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Formulas, Functions and Charts

8.1 INTRODUCTION

In this leson you can enter formula and functions and perform
mathematical calecualtions. You will also be able to create charts
and graphics using the data. You can specify methamstical
relationship between the numbers using the formula. Formulas
are used for simple addition, subtraction, multiplication and
division as well as for complex ecalculations. Functions are built
in formulaes., The users have to provide cell references and
addresses only. These are called arguments of the function and
are given between the left and right parenthesis.

8.2 OBJECTIVES
After going through this lesson you would be able to:

. use formulaes to get the desired result
° insert and edit picture from a file

B use functions

® create varioius charts

. draw graphics using clip art,
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8.3 FORMULAS AND FUNCTIONS

To mampulate data and to extract useful information from Excel
worksheets, formulas and workshest functions play very
important role. In Excel, formulas are used to calculate results
from the worksheet data. When there 1s some changs in the data,
such formulas automatically calculate the updated results with
no extra efforts on the part of the user. There 1s a new feature
introduced by Excel 2007, which enables you to create formulas
which use columns names from a table, when you are working
with table: This feature helps the user to make formulas much
easier to read.

A formula can have any or all of the following elements

® Must begin with the ‘equal to' = sign.

] Mathematical operators, such as + (for addition| and / (for
division) and logical operators such as <, =

] References of cell (including named ranges and cells)

Text or Values

Functions related to the worksheets, for example SUM or
AVERAGE

The current cell in which you have entered a formula will display
the result after the formula is completely entered. Also, when you
select or click on a cell which is having some formula, the formula
will appear in the formula bar.

In Excel 2007, the formulas are available in the Formulas Tab. If
you click on the Formulas tab, you can see the corresponding
ribbon display with available formulas, as shown below.
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- Home Inggrt Paga Layout Farmutas Lhata Ravieiy Winw Draeeloper - WX
ﬁ ¥ AutoSum - * Lagical = u - ;‘ ) Daljee Blame = \@ m
[:_ Rroenthy Used = [ 4 Test - 8- ! B~ v i Fgiopily
(GTLT 5 Hamg Formuls  Calvulation
Punction [L8 Financial < I Dt & Time = [|L] * | hignoger B TrOAE O SHETED | Liditing -
Fundtian LiDiaey Peflvied flamm |
] - 3/
| i E F ] H | |
Formula = ety = —
Ba | Vo shests  Toestd | Tireesd |y Al Somlictenifetaly -
r Ready | 3 Ll =




Formulas, Functions and Charis :: 169

Following are a few examples of formulas:
(v il D = .

e Hame | Ingert FPage Layout Formulas Dt Revraw e
| e n_ - A =] |
=2 Copy
PRSI 2 Foimat Paintes |||/ B | [ B - | |2 ol <) | || R S5 |00 SN
Clipboard = Farnt - Aligrim
St - (% %K~ fu| =83=C3+D3+E3

Wi A | & | c ' D | E | e | G
1
2 MName PhwicJChErni:t Maths .E_nilish |Total |
_3 |Ashok Sharma 93, EE) 100 106] =B 3+C3+D3+E3

4 Rajesh =8 7E 88 B

5 Ratul 77 EE] 85 ag

6 | Anurag BS o] 78 77

7 Garurawv 77 77 as =5

£ | Prashant [+1:3 445 88 77

B  Taslim 77 [ S8 5

10 Ranjeora 55 77 73 77

11  Priyanka 77 55 [ T

12 ndAonika 8 g8 75 58

Fig. 8.2

In the above example, in the cell F3, just type = B3+C3+D3+E3.
It will return sum of the marks in physics, chemistry, maths and

English.
|Name Physics| Chemistry Maths English || Total
Ashok Sharma 25 55 100 10§: 3s8
Rajesh 88 76 ss |
'Ratul 77 33 66 e |
| A rag 88 B3 7B ':‘1 |
| Garurav 77 77 98 54 |
|Prashant 85 44 a8 7'!' ;
[Taslim 77 66 98 ]
Ranj=eta 55 77 78 |
| Privanks ¥7 55 g2 '
[Morika ge g8 75 1! :
|Neealam ge 77 &7 54 |
Deepsk 77 99 87 S |
|Etakshi 55 88 87 54 |
|sonakshi 65 77 58 7H |
[Gunjan 77 56 a8 “;TF |
Mohit 88 77 77 |
Chhavi a9 88 65 84
| Kaku 77 99 28 L | ]
e——

Fig. 8.3
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Copying a formula

In above exaple just drag the handle and bring down to cover the
remaining cells 1 the column total. This will automatically copy
the formula and calculate the corresponding sum of the
respective rows of the other students.

rMame Phy:ic:] Chemiztryd Maths Englizh
Ashok Sharrma oG b OO0
Rajesh 85 76 858
| Ratui FiFd SS9 =206
Anurag a8 B8 78
Sarurawv 77T TF7 S8
Prashant =1 - 88
| Taslim TF7 5& o8
| Ranieseta 55 Fard -3
| Privanks 7 =5 =2a
InMonika 85 &8 76
Naeaslam = 77 a7
Desepak T 59 87
JElakshi S5 E3 7
Sonakshi 55 TFT 56
Gursjan TT S g3
MRt p=3:] 77 i
Chhawvi 99 23 =1=3
Kaku rad S5 88
Fig. 8.4

Some other examples of formulaes:
HA1=2,B1=3,Cl=4,D1=35then
(ifi =B1*Clwillgiveresultas3*4=12
f) =A1*Bl1-Cl+Dlwillgiveresultas2*3-4+5=7
(it = ((Al *B1) + C1)/D1 will give result as ((2 * 3) + 4)/5
=6+4)/5=10/5=2
Auto sum feature

The sum of cell values can also be done with the help of AutoSum
feature also.

Following steps explains how to do that.
. Click on the cell F3.

@ Select the Formulas tab
. Click AutoSum from the function library group.
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L Select Sum
» Press Enter

Alternatively, you can write = SUM(B3:E3) in the Cell F3 to get
the sum of the Physics, Chemistry, Maths and English marks.

Pictorial ilhustration is shown below:

DL
Hame Insert Page Layout || Formulas Data Review

K| Z|B @8 @ (@ 0 @
Insert AltaSumiBecantly Financial Logical Test Date & Lockup & Math
Functian = fa - " » Time = Refergence =~ & Trng ~
X .S5um Function Library
i Avelage ..Er[ _
I Count Numbers _ | [} ‘ £ e | G
1 | hiax
2 Namg (e istryiMaths  |English [Total
3 |Ashol Mare Functions... % 100 100
4 |Rajesh 1= 76 g8 88
5 |[Ratul T ag 1] =11
L& | 8 | ¢ | b | E |BB 6 H
(Name _[Physics(ChemistryMaths [English [Total
|Ashok Sharma) 99| 93 100]  100)=SuUM|
Rajesh 80 76 88 88| | SUMinumberd, [namber, ] |
Ratul i 99 66 99
[ - - z -———————= =
| A | 8 c |l o [ & _|E
1
2 Name Physics| Chemistry| Maths
3 |Ashok Sharma 99 99 100
4 Rajesh 88 76 88
Fig. 8.5

Apart from sum there are other functions also, like average, Count
Numbers, Max, Min and many other Functions.




172 :: Data Entry Operations

f | == AutnSuma ﬁl Loaog
= Sum
Insaert
Functiomn Everage

Count Numbars
Pl

! | l M

= ;IASI"'HJ rMore Functions...

-—

w
L . - L ——— i E—

- .

Fig. 8.6

Sum ( ) : Adds all the numbers in a range of cells.
Syntax SUM(numberl,number2, .. )

Maximum number of arguments can be 255 i.e. numberl,
number?2 ... number2335.

Sum function is having different forms. You can choose as per

vour need.
v - O Xl ] =i
¥ A T = 0 E bl s H i =

1

2 Name Physics ChamistryMaths |English [Total

1 | Ashok Sharma 59 a9 100 100} =su
4 |Rajesh ad 78 £8 83| | [ &da s the aameert in @ aage of cie |
5 |Ratul 17 a9 dd ag| | A suer

6 |Anurag & 88 i 77| | 4 s

! Garuray L4 T 98 55 ": WT

& | Braghant 2] a4 &3 " ﬁ SUMIZMYZ

8 Tanslim T4 (1 58 48| | & sumceve
10 | Ranjeata 55 n " 7] | s
il Arlammlow 9 L3} & i ] I

| A B C D E F |l

1

2 Name Phy:l:Jl:hlmistryIMlth: English I'l'utll

3 |Ashok Sharma 99 99 100 100} =sum{B3:E3)
4 Rajesh 88 76 98 88

= i F 1 — - - -

Fig. 8.7

SUMIF(range, criteria, sum_range) : This form of sum functions
is used to add the cells with respective to a given criteria.

Range : A group of adjacent cells
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Cells within a range must be numbers or names, arrays, or
references which are having numbers. In sumif function the
blank and text values are ignored.

Criteria: [t can be a number, expression, or text to define which
cells will be considered for the addition e.g. criteria can be fixed

as 12 *12%,

“=127, or "mangoes’.

Sum_range: These are the actual cells to be added if their
corresponding cells in range match criteria. In case the
sum_range is avoided, then the cells in range are both evaluated

by criteria and added if they match criteria.

Example
'IE:; H 0= ’ arunBakshiChapterFormatiing mnd formu
-\ Home  Insert Fagelayout | Formufs [zita Reviewy  View Uevelnper
' 2 Drefina Hams b
I E m @ ﬁ |—‘J ﬁ ﬁ @ @ — i oz
Imsedt | AutoSum: Recently Financial luq:r:i Ted Dated loskup & Math  More Ha FoF
Fundion Ut = Time= Reference = & Trig = Fumctions ™ rmu,.r = Lreatd from Seiadion
Funrtmn Luhur, Defined Mames
. M
. A B L V. E E |_ﬁ_ oo me b K
2 Name PhysicsChemistryMaths |English [Total [Sumit | N\
3 Ashok Sharma 83 2 0 108 iEE}dUMIFﬂﬂE:EB,"}EB"‘EEEﬂ
4 ‘Rajesh £ 76 88 { SUNIFirangs, eeitaria, (sun_ange] |
1 T Li L \
Formula Bar

In above examples, the function SUMIF adds only those values
in the cells (B3, E3) which are greater than 99. i.e., it will add the
values from cells D3 and E3 only and hence the result is 100 +

100 = 2000
| 4 . Su | sUM{Ba:ER)
| F— it
i B = &] E F G H
1
: [Nemae Physics Chemistry Maths English |Total lSumif
3 |Ashok Snarma a9 94 100 100 388 agd
4 |Rajesh BE 78 B Bal 340
. - . i — ey ~rie

Fig. 8.8
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Average function ( ) : It helps you to get the average of the
numbers. It returns the average (arithmetic mean| of the

arguments.
Syntax : AVERAGE{number, number2,...)

Maximum number of arguments can be 255 1.e. numberl,
number?2 ... number2355.

| Puineliiai LHrrary Delw
E SLM = (2 X & [ =hverage(B3:E3)
| A B c B | E F 6 Luowa
i
2 Name Physics ChemistryMaths |English [Total
3 Ashok Sharma 33 ac 100 100] 398
4 Rajesh 58 76 g8 2a] 340

H il e | =AVERAGE(B3E3

A 8 c D E | F G lnmanl
1
2 Name Physic t:hmlnq{nmh: English |Total |Sumif |EE!MI“
3 -Ashok Sharma 99 99 100 100 398 2
& Ralesh 88 78 B8 88l 340

Fig. 8.9

Min function ( ) : It helps you to get the minimum of the
numbers.Returns the smallest number in a set of values. Syntax
MIN(numberl,number2,...)

Maximum number of arguments can be 255 1.e. numberl,
number2 ... number255

S LA W Ll:m"-lj!.ﬂ.'

i A B c 0 £ F G " i f
1

2 Namae PhysicsChemistryMaths _ |English [Total [Sumif  |Average Min |

3 Ashok Sharma EE) 35 100 100]  as 200 99 shrmin{83.: 1}
2 RsmTn R ™ T ARl man 1

TR

| nlt 05 0P |

1 A 8 C 0 : i G " i

1

: MName Physlesd ChemistryMaths  |English [Total Sumif  |Ave

1 i;nah Sharima o] a5 100 100 358 00 5. 9
4 Rajsah L] 76 5] EB) 340

Fig. 8.10
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Max function () : It helps you to get the maximum of the
numbers. Returns the largest number in a set of values. Syntax

MAX(numberl,number2,...)

Maximum number of arguments can be 255 i.e. numberl,
number?2 ... number255.

| 5LM = % o f| =maxi83E3)

[ 4 A Bl e [ B | E _|E | G

1 |

2 Name thﬂ;iﬁ‘lmﬂlﬂhs EEn;Iiuh Total [Sumif  |Average |Min _

3 |Ashak Sharma 53 0D ol %8 el sas a.-. :l
4 Rajesn EEl ?E B3 68| 340 [

i ~ £

i A [T ¢ | o | & |.F a [ W [ i S
1 .

2 |[Mame PhysicsChemistry|Maths _ |English _[Total |Sumif _ |Average |Min Max
3 |Ashok Snamma: 35 &4 25 ol 398 200/ 995 53

Fig. 8.11

Neow drag the handle of cells G3,H3,13,J3 to cover each row of the
respective column. You can see the corresponding functions are
automatically copied in the respective columns and automatically
values are calculated. See the figure below.

m L L T e T
¢ 3
—f) - frnank P Lyl Fosmsiples | Dagls [ TE— TS Ela g

S 2 D E S A0 0 E @ 9;’."‘?’1‘.‘:

g gl i LTl 'Ilﬂlhll lir-nl'.ll fhl' ate b Rl G RRih Sl

Pl *nea e Fiser * Eefnrerin * g Nig = Pubisiiss » { saper BED Crmake o S0
| — = h-_i-t_mmm L T
) Y com—
h- L L] T 1] L L) ] ¥y ' i
]
7 Neme [Ehysisachamistogiiathe [Engllsh [Tetal v Average |Min m-q
3 Ashok Nearia . - 100 T T T T an inef
& Awain 5 T [T s8] sac gl a3 [ 2
3 Ratul 2] Y [T [T ] 0338 7] 3_
B Anureg [T} ;.51 i o [ N £
P Qe T? kLl 84 307 ol T TS Lid T
L AL ] 8 & L. Led Y ] T fie =
b Tmaiiem r1 [T [T Wil aom o e re a3
10 Ranpeats 33 n o T g R 33 y
11 Priyanss 2] &4 Ba ST [ T3P [ 2] EE B
12 Mgriss T sl i [ :s-:f [ §7 4] a8 m+
1 Meelem J 3 il [ [ | | Ti S an [
14 Dawpaa 7T - (LS 3al msl of 5 7
13 tiaagni ) T T Afil  sap ol s an 3:
18 Yurshite 4 i [ T ol ' ™ i
1T Gunjad Fil :I;i i | 297 vl 125 Tr [y
LB Mok i ¥ T [ [T [T
19 Cnmawi [ pel il an|_ by [ Y [T “j"
P HrrTm 77 | [T C ) I | a0 ¥F

Fig. 8.12
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To use more functions

® Select Formula Tab
° Choose AutoSum from function library group, from formula

ribbon
3 Chick o More Funetions... as shown below,
™ i SR ¥ AfunEaatha nantsf
Hame lvsert Pa';_r L_ﬂf-‘.-ut Fownaulas Tala R Wi v loped

AToed-0 a8 @ 9

lrdeit EutaSuliiRecantly Finandal Logical Ted Dale & (ookup &  Muth Fdoie Flarns =

Fungticn ¥ Lhad - = - - Tims = Feferends * & Tehg = Funetiond = | Lisnggs B Crewtz
. | x Tum !::.lr'-:'h.'. rl.l.ll'l‘ rr_,._ = = _:"-.- P..—_rn 5 i.
s &

1 | ot Numbeds [“__ _D E T | E _"'l —

3 | AEY

2 Name KA [stryl Maths English |Total |Sumif |Average |Min Maa

3 .a.sr.na:_l' PTG 29 190 100| 398 200 333 33

4 ‘Raiesh R 76 28 ga| 340 [ &5 8

Figr s‘r 13

When you click on more functions, a dialog box will appear as
shown below. You can choose a function as per your need by the
help of following dialog box.

Insert Function Bed s |

sSurs-{number I number2,..)
Adds all the numbers In & range of ceils,

Fig. 8.14
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8.4 CHARTS

Charts allow you to present data entered into the worksheet in a
visual format using a variety of graph types. Before you can make
a chart, you must first enter data into a worksheet. This section
explains how you can create simple charts from the data.
Formatted charts come in various types for diverse goals, ranging
from cohamns to pies, from hines to surfaces, etc.

8.4.1 Types of Chart

Microsoft Office Excel 2007 provides various types of charts to
help you to display data in different ways as per the need of the
viewers. You can create a new chart or can change the existing
chart, from the wide range of chart subtypes available for each
type of available chart types as given below

Column Charts

This type of chart is used to compare values across categories.
They give very effective results to analyze the data of the same
category on a defined scale.

Line Charts

Data represented in columns or rows in a worksheet can be
plotted with the help of line chart. Line charts can be used to
display continuous data over time with respect to a common
scale. Thus Line Charts are best suitable for viewing data trends
at equal intervals of time. The horizontal axis 1s used to represent
the category data and all the value data is distributed uniformly
along the vertical axis.

Pie charts

In a situation where one has to show the relative proportions or
contributions to a whole, a pie chart is very useful. In case of pie
chart only one data series is used. Small number of data points
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adds more to the effectiveness of pie charts. Generally there
should be maximum five or six data points or shices in a pie chart.
If the points are more in number then it becomes very difficult
to interpret the chart.

Also, it 18 very important to note that the values of to be used in
the pie chart must be all positive. If there are some negative
values, in that case the negative values will be automatically
converted in to positive values, this will be desired,

Bar Charts

Bar charts are used to show comparisons between individual
items. To make a bar chart the data should be arranged in the
form of rows and columns on a workshest.

Area Charts

The data which is arranged in the form of rows or columns on a
worksheet can be plotted in an area chart. Area charts are used
to highlight the degree of a change over time. Area charts are also
used to draw attention to the total value across a trend.

XY (Scatter) charts

XY charts are also known by other names like scatter grams or
scatter plots, The point of difference between XY charts and other
types of charts is that in XY charts both axes display values i.e.
they have no category axis, Such type of charts is generally used
to show the relationship among two variables.

Stock charts

Stock chart can be used to plot data arranged in columns or rows
in a particular order on a worksheet. As the name is self
explanatory, this chart is used to demonstrate the fluctuations
with respect to stock market prices. Even scientific data can be
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plotted by stock chart, e.g., the fluctuation of daily or periodic
temperature. The data must be arranged in a correct order to
generate stock charts. Say, for sxample to make a simple high-
low-close stock chart one should organize his/her data with High,
Low and Closed entered as the headings of the columms in the
respective order.

Surface charts

Such type of chart is used in situations where both categories and
data series are numeric values. This type of chart 1s useful 1n
situations where the optimum combinations are found among the
two sets of data. Data should be arranged in columns or rows in
a worksheet can be plotted in s surface chart. The colors and
patterns indicate the areas which are in the same range of set of
values, as it happens in case of a topographic map.

Doughnut charts

The conditions to draw doughnut charts 1s that the data has to
be in the form of rows or columns, As in the case of a pie chart,
the doughnut chart illustrate the relationship of parts to a whole,
but it is able to get more than one data sernes.

Bubble charts

A bubble chart can be used to plot the data values which are
arranged in the columns of a worksheet so that x values are listed
in the first column and matching y values and bubble size values
are listed in adjacent columns.

Radar charts

The radar charts compare the aggregate values of a number of
data series. Radar chart can be plotted with the data which is
arranged in columns or rows on a worksheet.




180 :: Data Entry Operations

8.4.2 Components of a Chart

Y Axis Vertigal Major Gnd

¥ Axis Tith VT‘ . c[ﬂT"ﬁﬂg: Hiceh ¢l Maior Grid
; | / Dya

Result of Students

Naime of students 4 X AXis

li'r?u BChesyaty My NBoosy §Inglith

/
Tick | Legend

Fig. 8.15
Chart Title - A title given to the whole chart.
X-Axis Title - A title given to the X-axis data range.

Y-Axis Title - A title given to the Y-axis data range.

X-Axis Category - These are the categories of the data which have
been plotted. These are taken from the first column or first row
of your data range.

Y-Axis Value - This is the data range marked to plot the data
series,
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Data Labels - The valuss of the data series plotted.

Legends - Specifies the colour, symbol or pattern used to mark
data series.

Tick Mark - These marks are used to show the scaling of X-axis
and Y-axis.

Grid Lines - Displays linies at the major intervals on the category
(x) axis and/or Y-axis

How to Draw a Chart in Excel 2007

In Microsoft Excel 2007 chart wizard is removed and also not
brought back in Excel 2010 also. Instead the ribbon 18 provided
as a new place to get your chart related needs full filled. The
buttons on the Insert tab of the ribbon are just the starting point
to make a chart. After we get the nibbon it becomes very simple
to start making a chart. Whenever we click on some component
of chart, we observe that the Chart Tools are displayed to the
ribbon. Three additional tabs which provide a variety of chart
design, layout and formatting options, will also be added.

First, the Layout tab, 1s used to add all sorts of elements related
to chart or change the way they are shown in the chart. Second,
the format tab is used to apply special effects which were not
available in the earlier versions of the Excel, such as the bevel
effect ete. It may be little difficult to be acquainted with this new
type of chart interface, but once you start working, you'll be proud
to show off your professional locking results.

It is worth mentioning that you can right click on an element of
the chart for quick access to specific features with respect to that
particular element e.g. if you right chck on any chart axis, you will
get Format Axis dialog box.

Following steps are given to draw a Chart

1.  Enter data in the work sheet: Suppose you entered data as
given in Fig, 8.16,
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2.

3.

X

Fig. 8.16

Now select data range: By using the mouse high light the
range of data you want to take (see Fig. 8.17).

[ @ -0 ) ¥ ArunBakshiExcelDémoShest A = =
Home Insert | Page || Formu | Data | Revies | View | Devel | @0 = = X
» a3 é__ﬁiame z
| B B | C D JE F
1 [Name |Physics  |[ChemistryMaths  |Biology [English
2 Ravi 80 e 79 77 88
3 Shanicar 70 77 98 66 17
4 Mohan S0 &7 56 78 68
5 Rajneesh 98 87 56 98 78
6 Shweta 99 56 66 77 a8
7 Komal 98 78 77 68 76
8 Amit 87 76 93 89 67
r? 4 b M| Sheerl -
ready 5}

ol 9 - ) |5 AunBashiExcelDemoshest A - m X
s Home | Inseit | Page | [ Farma| Data | Reviey | View | Deved @ — = X |
Al o, - A | Name ;‘

| - :

LN i B, | £ 12 Bl UR

1 |Name  [Physics  [Chemistn|Maths  |Biology |English |

2 |Rawi 80 88 79 77 28| |
3 [Shankar 70 7 98 66 |
4 [Mohan 90 67 56 78 68

5 |Rajneesh 38 37 56 38 78
| § |Shwets 99 56 66 77 98

7 |<omai 98 78 77 68 76

8 87 76 99 83 67

5|

R Ehntl

wnmnm Count: 48 Sum: 2787 e B

Fig. 8.17

Click Insert Tab and select a chart type from the chart
group
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fj M-+ ArunBatshiExcsDemosheet - Mitrosoft Sncel .= ox
By : .
_ Home @ﬂum Formuai  Dath  Redew  View  Delopy 0 M0 - X
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Fig. 8.18

4.  Select the sub type of chart

1A | | LAexh

llEr = Cihoart T oS ..

Fig. 8.19
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Fig. 8.20
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5.  Select the Title of the chart

a. To give a title to a chart, click on the chart. Now you
can see layout tab available. Click on Layout tab.

b.  Choose{click] on chart title option available in the

Label group
ﬂjju o I e T Arnafpkeh®uca|Dematheed - Mcrotoft Dol R han - x|
s 4
Wi Buet ugelsi  Voiiniles  Osfa  Bpdes  View s Doy @ e ®-.27
| cnait doh « " all mree =i ) e - - Al A owtn -
} Fatmik elesinn ,:r' Lhapas = —hJ : 18 Diaiin Lot = J —‘.-il g ] I —"-i .
A hips  Qodingg | Pal fampioy b=y
O it Mtabin Tigle | Tasd Bos @ e+ Ll Sk Tabls * + » e [ ik o [ et B - .
Cnirpl Eabptfisn iy (FTETH dawy Hualyiaims AR
thand el k] 3
| .ﬁ:“-_ B C 0 £ £ & [ i i L M N
| Mame_[physics [Chemisirimtathy _|tinlogy | . =
2 Hawl a B 74| ] m | 3
i Shamear 1 7 sl eel 7
4 Mahen 3y 61 sal m e
5 Rajneein L ¥ 58] ag] 7| 11— B 5
& S EE] 5 i 1| | =
T Kol 9 n il 2] | g * '
§ amit 7 7 94 89 2 & | _ : f
3 )
10 ! L . = k3 I
11
L ) ' '
13 .{ j
1 j f f j f
15 1}
R “onggry  Sheell Sliesti] _,J'.'!. —
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c. Click on the chart title and write a title.

Result of Students
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; f R j -

Fig. 8.23
6. Give a name to X-Axis
Click on Layout tab. Then select Axis Titles from Labels

Group. Select Primary Horizontal Axis Title, as shown
below.
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Result of Students
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Fig. 8.25
Now, click on the Axis Title and write an X-axis title.

Result of Students
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Fig. 8.26

Follow the same steps to give a title to Y-axis.
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Editing of a Chart

2

How to change the legend position

Click on Layout tab. Then click on Legend optien available
in Labels Group.

Now choose a position to show legend.
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How to change the position of the Data Labels

Click on Layout tab. Then click on Data Label option
available in Labels Group.

Now choose a format to display data labels
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3. How to show Data Tables Along with Chart, with or
without Legend Keys

Click on Layout tab. Then click on Data Table option
available in Labels Group.

Now choose a style to display data table
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>soft Excel
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Above diagram show the data table with legend option.
How to Hide /Unhide Grid Lines (Horizontal and Vertical)

Click on Layout tab. In the Axis Group, click on Gnidlines
option then choose Primary Horizontal Grid Lines. Now

select appropriate style from the available options (None,
Major Gridlines, Minor Gridline, Major and Minor Gridlines)

4,
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Follow the same steps for Vertical Grid Lines also, as shown

below.

a) Click on Layout tab, In the Axis Group, click on Gridlines
option then choose Primary Vertical Gnid Lines.
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b) Now select '-'appr_::-priaté 3tyie. from the available options
(None, Major Gridlines, Minor Gridline, Major and Minor
Gridlines)
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8.4.3 Resizing the Chart

To resize the chart, click on its border and drag any of the eight
black handles to change the size. Handles on the corners will
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resize the chart proportionally while handles along the lines wall
stretch the chart.

8.4.4 Moving the Chart

Select the border of the chart, hold down the left mouse button,
and drag the chart to a new location. Elements within the chart
such as the title and labels may also be moved within the chart.
Click on the element to activate it, and use the mouse to drag
the element to move 1t. Microsoft Excel automatically sizes titles
with respsct to the size of the text. One can move fitles wath the
motise but, eannot regize them.

8.4.5 Copying the Chart to Microsoft Word

A finished chart can be copied into a Microsoft Word document
or power point slide. Select the chart and click Copy. Open the
destination document in Word or a slide in power point and click
Paste.

8.5 GRAPHICS - AUTOSHAPES AND SMART ART

The AutoShapes feature of Excel 2007 allows you to draw a
number of geometrical shapes, arrows, flow chart elements, stars,
and more on the worksheet,

The steps to activate and use AutoShapes are
1. Click on Insert Tab.
2.  From Illustrations Group, Click on Shapes
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Now Select the which you want to insert.
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Different categories of AutoShapes available in Excel 2007. We
will briefly discuss some of the here.

1. Lines - After clicking the Lines button on the AutoShapes
toolbar, draw a straight line, arrow, or double-ended
arrow from the first row of options by clicking the respective
button. Click in the worksheet where you would like the line
to begin and click again where it should end, To draw a
curved line or freeform shape, select curved lines from
the menu, click in the worksheet where the line should
appear, and click the mouse every time a curve should
begin. End creating the graphic by clicking on the starting
end or pressing the ESC key. To seribble, click the last
button in the second row, click the mouse in the worksheet
and hold down the left button while you draw the design.
Let go of the mouse button to stop drawing.

2. Connectors - These lines can be used to connect flow chart
elements.

3. Basic Shapes - Click the Basic Shapes button on the
AutoShapes toolbar to select from many two- and three-
dimensional shapes, icons, braces, and brackets. Use
the drag-and-drop method to draw the shape in the
worksheet. When the shape has been made, it can be
resized using the open box handles and other adjustments
specific to each shape can be modified using the yellow
diamond handles.

4, Block Arrows - Select Block Arrows to choose from many
types of two- and three-dimensional arrows. Drag-and-
drop the arrow in the worksheet and use the open box and
vellow diamond handles to adjust the arrowheads.

5. Flow Chart - Choose from the flow chart menu to add flow
chart elements to the worksheet and use the lines menu
to draw connections between the elements. We have drawn
a flowchart using lines, flow chart elements and connectors.

6. Stars and Banners - Click the button to select stars,
bursts, banners, and serolls,
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7.  Call Outs - Selsct from the speech and thought bubbles,
and line call outs. Enter the call out text in the text box
that is made.

Smart Art Graphics

Visual representation of information and ideas is called SmartArt
Graphics. They can be used to quickly, easily and effectively
commumnicate a message. Lhe facility to create a SmartArt Graphic
is available in MS Excel 2007. You can copy and paste SmartArt

graphics as images into other programs such as Word and
Powerpoint.

To create a SmartArt graphie, one has to choose a type for
example, Process, Cycle, Hierarchy or Relationship. A type
represents a category of SmartArt graphic. Each type is having
several different types of layouts.

Steps to Create a SmartArt

1.  Click on Insert Tab.
2.  From [llustrations Group, Click on SmartArt
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and arganization charts.
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Fig. 8.42
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3.  Now choose a category (Say Hierarchyj and click OK.
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4.  Now you can enter the values as shown below. To enter
values just click on the component where you want to enter
text and write the text,
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Type your text here

Pattern
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You can apply different effects on the SmartArt, by the help of
Design tab, Click on SmartArt. The Design tab will be visible with
its ribbon. Select appropriate group from the ribbon and apply
the desired effects.
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8.5.1 Adding Clip Art

Clip.is a single media file, including sound, animation, art or
movie.

Steps to insert a Clip Art

1. Click on Insert Tab.

2.  From Illustrations Group, Click on Chp Art

3.  Then Select a Collection and press Go Button

4.  Click on a clip from the collection
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9.  Clip will be inserted in the workshest.
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6. To edit the clip, Just click on the clip. This will display
Format tab. Choose the relevant group from the ribbon of
Format tab and do the necessary changes.
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8.5.2 Inserting and Editing a Picture from a File

Follow these steps to add a picture, photo or graphic from an
existing file:
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1.  Click on Insert Tab.
2.  From Illustrations Group, Click picture.
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3.  Now select a picture from the location of the picture (where
you have stored the picture] and press enter or click on

insert button.
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4.  The picture is added on the excel sheet. Click on the
picture to activate Format tab as shown below along with
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its ribbon showing groups like Adjust, Picture Styles,
Arrange and Size. Use any of the groups to make necessary
changes in the picture appearance.
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INTEXT QUESTIONS

1.  Write True or False for the following statements
(a) Format picture displays all the images properties in
a separate window.
(b}  Activate the image you wish to edit by clicking on it
once with the mouse,

[c) Line charts show the proportion of each component
value to the total value in a data sernes.
(d}  Pie charts are useful to compare the trends over time.
2.  Fill in the blanks
(a) Each autoshape can be rotated by first clicking
button on the drawing tool bar.

(b) More effects can be changed using the
picture toolbar.
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() displays all the image properties in a
separate window.

(d) show the relative contributions that
each data series takes up.

(e}  You have to enter the name of the chart and titles for

8.6 WHAT YOU HAVE LEARNT

In this lesson you learnt about the creation of charts and graphics.
On the basis of data entered in a worksheet vou can create a bar
chart, line chart or pie chart, you can add title, legend, data labels
and grid lines to the chart. Moreover, you learnt about
autoshapes and clip art also.

8.7 TERMINAL QUESTIONS

9

mEah

10.

What is the importance of charts and graphics in providing
information?

Briefly explain any five different components of a chart?

Explain the process of creating a chart using Chart Wizard
dialog box.

Briefly explain the following:

a. Bar charts,

b: Pie charts,

List any four features of Chart Formatting toolbar.

How do you copy a chart to Word created in Excel 20077
List any five categories of AutoShapes in Excel.

You are asked to prepare a flow chart. What kind of
AutoShapes you would like to use?

Explain the steps in adding a Clip Art to your worksheet?

How do you add a photo or graphic to your worksheet from
existing file?
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11.

12,

What is the main differences between (a) a column chart
and (b} a bar chart.

Write a note on SmartArt.

8.8 FEEDBACK TO INTEXT QUESTIONS
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lal
(b
(e
(d)
(a)
(b)
(e)
(d)
(e

True

True

Falzse

False

free rotate
picture
format picture
Area charts

Y axes




